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LAB PROJECT # 1: 
 

Measurement of Static and Kinetic Coefficients of 
Friction  
 

OBJECTIVES 
In this lab you will 

 Investigate how friction varies with an applied force. 

 Measure the coefficients of static and kinetic friction. 

 Learn how to use a force sensor. 

 Plot and analyze data. 
 

EQUIPMENT  
 Force sensor and lab pro 

 Wooden block (friction tray) 

 Masses  

 Data collector  
 

THEORY   

The friction forces that arise between any two contacting surfaces are divided into two broad categories based on the 

relative motion of the surfaces. Static friction exists whenever there is no relative motion and kinetic friction 

whenever one surface moves relative to the other. The magnitude of each friction force depends on the number of the 

chemical bonds formed between the two surfaces and their average strength. The direction of each friction force is 

always opposite the horizontal component of the applied force.   

Suppose you wish to slide a heavy box of mass m along a horizontal surface with a force F. As you increase F, an 

equal and opposite static friction force fs arises to keep the box at rest until F equals the maximum value of fs:   

  fs (max) = μsN        Equation 1. 

where μs is the coefficient of static friction and N is the normal force. When F exceeds fs (max), static friction is no 

longer present. The box now slides in the direction of F. A kinetic friction force fk now acts to opposite the motion. 

Unlike its static counterpart, fk does not match the applied force up to a maximum value. Its magnitude is constant and 

given by the formula   

  fk = μkN         Equation 2. 

where μk is the coefficient of kinetic friction. If you wish to slide the box at uniform  st velocity, then F must equal fk 

by Newton’s 1 Law. However, if you accelerate the box  then F > fk by Newton’s 2nd law of motion. Coefficients μs 

and μk are depend upon the average bond strength between the two surfaces. The normal force along a flat surface 

is simply equal to the weight of the object, or N = mg. N is an indirect measure of the number of bonds formed between 

the two surfaces. In other words, heavier objects require greater forces to get them moving because they press their 

supporting surface tighter thus forming more bonds.  
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Figure 1: A mass m pulled along a rough surface 

PROCEDURE 

1. Disconnect the motion detector from the Lab Pro interface. Connect the cable of the force sensor to Channel 

1 of Lab Pro.  

2. Measure the mass of the wooden block and record the value on your data sheet. 

3. Fasten a piece of string to the hook on the force sensor, and then fasten the opposite end to the hook on the 

wooden block.  

4. Brush off any dust and other debris. 

5. Set up the equipment as shown in the figure 2. Place the track on a flat, horizontal surface. 

 
Figure 2: Experiment set up 

6. Place the felt friction accessory tray on the track with the felt down. 

7. Make sure you can see the graph labeled Friction Forces vs. Time. Hold the Force Sensor horizontally a few inches above 

the track. With slack in the string, press the zero-button on the sensor. To zero the Force Sensor when measuring 

horizontally, with the Force  

8. Sensor oriented horizontally, press the zero button.  
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Figure 3: A wooden block + masses pulled with the force sensor 

 

9. Gently pull the force sensor with a horizontal force F as shown in Figure 3. Increase F slowly and steadily until 

the wooden holder begins to slide. At this point, you may have to decrease F so that the holder maintains a 

uniform velocity.  

10. With out the masses or any mass you perform the first pull. Repeat again for second trial. 

11. For a second run, add a 250-gram mass bar to the wooden block and perform the above procedure again 

(Set-up 9). Don’t forget to zero the sensor before recording data. Repeat again for second trial. 

12. For a third run, add a second 250-gram mass to the wooden block and perform the above procedure again 

(Set-up 9). Repeat again for second trial. 

13. Make sure there is a slack in the string (i.e. zero tension). Do not pull the system till you calibrate the force 

sensor.  

14. In tables below record all the data: the mass of the wooden block, total weight, static and kinetic force, and 

their coefficients. 

15. When you get your recorded data for the force-time graph you must plot the graph by yourself and it should 

look exactly like figure 4. 

16. From your force-time graph take the average force and use it as your approximate kinetic force and the peak 

value to be your static force( fs (max)) and find their coefficients.  
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Figure 4: A sample force-time graph 

 

RESULTS  

Please in this section tabulate the data recorded by the force sensor and illustrate them in a force-time graphs.  
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DATA AND ANALYSIS  

Mass of the wooden block =  ………………. kg 

Table 1: Static friction data 

 Total Mass 

(kg) 

Total weight 

(N) 

fs (max) Trial 

1 (N) 

fs (max) Trial 

1 (N) 

fs (max) 

Average (N)  

μs for fk 

Average 

Wooden Block       

Wooden Block 

+ 250g 

      

Wooden Block 

+ 500g 

      

 

Table 2: Kinetic friction data 

 Total Mass (kg) Total weight 

(N) 

fk  Trial 1 (N) fk Trial 2 (N) fk Average 

(N)  

μk for fk 

Average  

Wooden Block       

Wooden Block 

+ 250g 

      

Wooden Block 

+ 500g 
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QUESTIONS 

Q1. For a fixed trial, compare your values for the average maximum static friction force (Table 1) and the average 

kinetic friction force (Table2). Based on your data, which one is larger? Is this reasonable? Explain your results.   

 

 

 

Q2. How do you expect the friction between the trays and the track to change as the trays and track are pressed 

more firmly against each other (that is, as the normal force increases)? 

 

 

 

Q3. Does the average kinetic friction force vary as the total weight increases? If so, explain why.  

 

 

Q4. For a particular weight, compare the coefficient of static friction and the coefficient of kinetic friction. Based 

on your data, which is larger? Is this reasonable? Explain your results.   

 

 

Q5. What are the SI units of these two coefficients? Justify your answer using Equation 1 and 2.  
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LAB PROJECT # 2: 
 

Conservation of Momentum 
 
OBJECTIVES 
The aim of the experiment is to study the conservation of momentum experimentally in inelastic and elastic collisions.  

EQUIPMENT 

 Data collector 

 Two motion sensors 

 Two magnetic/friction carts  

 Horizontal track  

 Mass blocks  

 

Figure 5: collision set-up 

 

INTRODUCTION AND THEORY 

Collisions are an important way of studying how objects interact. Conservation laws have been developed that allow 

one to say quite a bit about what is happening without knowing the exact details of the interaction during the collision. 

In this lab, you will show that the total momentum of the system is always conserved when there is no net external 

force acting on the system, and that the total mechanical energy of the system is only conserved in certain kinds of 

collisions. These principles are important in studying automobile collisions, planetary motion, and the collisions of 

subatomic particles. 

Momentum is the product of mass (m) and velocity (v), so it has the units of kg·m/sec. Momentum is a vector quantity 

with its direction the same as the velocity. We do not have a special name for the unit of momentum, but we do 

commonly use the letter p to represent the momentum vector. 

p = m · v         (1) 

Conservation of Momentum is derived in your textbook using Newton's Third Law, and also deals with the quantity 
called impulse which is force × time, where time is the time interval over which the force acts. In a closed system, 
momentum is conserved when objects are interacting with each other. 
 
In this experiment, we will be dealing with collisions in one dimension. The motion of the bodies involved is constrained 
to a horizontal track. This means that the velocity and momentum vectors can be only in one of two directions, +x or –
x, where x represents the coordinate along the track. Since we will be dealing with only two bodies, the Law of 
Conservation of Momentum can be written as for two bodies: 

 
m1(v1)1 + m2(v2)1 = m1(v1)2 + m2(v2)2                (2) 
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Thus, in order to prove conservation of momentum, we must know the masses of each of the two bodies and their 
vector velocities (magnitude and direction) before and after the collision 

 

PROCEDURE 

1. Set up the equipment as shown in the figure 1 

2. Place the dynamic track on a table and ensure that the track is leveled. 

3. Place one motion sensor at each end of the track. 

4. Connect the sensors to data collector. 

5. Place two carts on each end of the dynamic track, both facing each other. If the cart rolls one way or the other, 

use the adjustable foot at one end of the track to raise or lower that end until the track is level and the cart will 

not roll one way or the other. 

6. Adjust each sensor so it can measure the motion of a cart as it moves from the end of the track to the middle 

and back again. 

7. Assumptions: the track is leveled, friction is negligible, and direction doesn’t matter. 
8. Start recording the collision data on to the Data collector. 

9. Manually push both carts to create the collision. 

10. You can repeat steps 7 and 8 with the same magnetic carts 

11. Add a mass block to each magnetic cart or any of the carts. 

12. Manually push the carts to create another collision. 

13. Record collision data on to the Data Collector. 

14. Repeat steps 10 to 11 with same magnetic carts with extra masses and record the data. 

15. Measure the velocity of both carts before and after the collision and record the dat.  

16. Find the initial and final momentum as well as right before and after the strike.  

17. You can iterate the experiment to higher the preciseness of your data. 

 
For inelastic collision 

18. Turn the carts so the Velcro on each cart will stick together when the carts collide. 
19. Repeat above procedures. 
20. Make sure that after the collision the carts stick together and move with some velocity common to both. 
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EXPERIMENTAL DATA & ANALYSIS 
 

Check the observed data by the aid of equation one. Uncertainties should be taken into account to have the 

preciseness and error analysis in your reports; you may neglect the uncertainty of all masses. In each measurement, 

you need to find all the initial and final masses and velocities, and use them to calculate the initial and final total 

momentum and tabulate your results. WRITE DOWN THE ERROR ANALYSIS. 

 

Mass of Red cart (m1) =___________ 

Mass of Blue cart (m2) =___________ 

 

Table 3 Observed data Before Collision 

 

 

 

 

 

 

 

 

 

 

Table 4 Observed data After Collision 

 

 

 

 

 

 

 

 

 

 
 

 Mass of the carts  Before Collision 

m1 m2 Velocity Momentum 

Iteration Cart 1 Cart 2 Cart 1 Cart 2 Cart 1 Cart 2 

One       

Two       

Three       

 Mass of the carts  After Collision 

m1 m2 Velocity Momentum 

Iteration Cart 1 Cart 2 Cart 1 Cart 2 Cart 1 Cart 2 

One       

Two       

Three       
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RESULTS 

 

1. Plot the graphs of velocity and momentum of each cart once separately (for any iteration, but do specify which) 

versus time. 

2.  Plot the graphs of velocity and momentum once all together (for cart 1 and 2) versus time.   

 

ANSWER THE FOLLOWING QUESTIONS  
 

1. Differentiate between elastic and inelastic collision.  
2. What can you conclude about the relationship between the momentum before and after an inelastic collision? 
3. How the momentum equation is created? 
4. How the momentum conservation is created? 
5. Explain the reason why a spaceship can start flying and leave the earth through conservation of momentum 

concept. 
 

DISCUSSION & CONCLUSION  
 

State your observation during the experiment. Support your memo by mentioning the error sources, which affect the 

accuracy of results and analysis. Did you conserve momentum? Was there a bias? ? In your report comment on 

whether your predictions and assumptions were correct, and if not, why? What conclusions can you draw? 
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LAB PROJECT # 3: 
 

Modeling of a Four Bar Mechanism 

Simscape Multibody Bodies 
Rigid Body Essentials 

Bodies are the basic components of a Simscape™ Multibody™ model. They are the parts that you interconnect with joints and 

constraints to model an articulated mechanism or machine. As an example, a four-bar linkage contains four bodies, each a binary 

link, which interconnect via four revolute joints. The figure shows the four bodies, labeled A–D. 

 

In a Simscape Multibody model, all bodies are rigid. They are idealizations in which internal strains always equal zero. True rigid 

bodies do not exist in nature but, under normal operating conditions, many engineered components behave as approximately rigid 

bodies—that is, with negligible deformation. In general, the rigid-body approximation provides accurate modeling results 

whenever the expected deformation is much smaller than the characteristic length of the modeled system. 

Rigid Body Properties 

Solid properties determine the appearance and behavior of a rigid body. For example, the moments and products of inertia 

determine the angular acceleration of a free rigid body in response to an applied torque. In Simscape Multibody, solid properties 

fall into three groups—geometry, inertia, and graphic—each with group-specific parameters. The figure lists these properties. 

 

To specify the solid properties of a rigid body, you use the blocks in the Body Elements library. The library contains three blocks, 

of which Solid is the most frequently used. This block enables you to specify all the solid properties of a rigid body in a single 

place. The remaining blocks, Inertia and Graphic, serve special cases, such as visualizing certain frames and modeling mass 

disturbances. 

The table summarizes the primary purposes of the Body Elements blocks. 
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Block Purpose 

Solid Specify the solid properties—geometry, inertia, graphic—of a simple rigid body or of part of a 
compound rigid body. 

Inertia Specify the inertial properties of a mass element, such as a mass disturbance present in rigid 
bodies. 

Graphic Select a graphical icon to visualize any Simscape Multibody frame in a model. 

Rigid Body Frames 

In Simscape Multibody, rigid bodies have frames, each identifying a position and orientation in 3-D space. These frames are 

important to the Simscape Multibody modeling workflow. They enable you to specify the correct position and orientation for each 

of the following tasks: 

 Connect joints and constraints between rigid bodies. For example, you always connect a revolute joint between two frames in 

separate rigid bodies (or, alternatively, between a rigid body frame and the world frame). 

 Apply forces and torques to or between rigid bodies. For example, you always apply an external force and torque to a single 

frame in a rigid body. 

 Sense motion, forces, and torques between rigid bodies. For example, you always sense the relative position coordinates 

between two frames on different rigid bodies (or, alternatively, between a rigid body frame and the world frame). 

The Solid block, the main component of any body subsystem, provides a reference frame through frame port R. You can create 

additional frames in the Solid block dialog box using its frame-creation interface. This interface is accessible from 

the Frames area of the Solid block dialog box. The Solid block adds a frame port for every frame that you create. 

Drawing a frame connection line between frame ports on different Solid blocks makes the port frames coincident in space. You 

can translate and rotate these frames relative to each other by adding a Rigid Transform block to the connection line. This block 

enables you to specify the pose of the follower frame relative to the base frame. 

The figure shows an example of a rigid body subsystem in Mechanics Explorer. The rigid body is a binary link with three frames, 

each associated with a solid section of the link—hole, main, and peg. Rigid transforms specify the translational offset between 

each pair of frames. 

 

In the binary-link block diagram, Rigid Transform blocks specify the translation transforms between the three frames. A total of 

two such blocks are needed, one between each pair of frames. The following figure shows the binary link block diagram. To view 

this subsystem, at the MATLAB® command prompt, enter smdoc_binary_link_a. 

 

file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/ref/solid.html
file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/ref/inertia.html
file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/ref/graphic.html
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Rigid Body Delimitation 

In a Simscape Multibody model, a set of Solid and Rigid Transform blocks between two joint blocks or between one joint block 

and the World Frame block constitutes a rigid body. During simulation, Simscape Multibody software computes the center of mass 

for each such block subset. Gravitational Field blocks in your model, if any, then apply a gravitational force at the calculated 

centers of mass. 

If you connect two halves of a rigid body using a Weld Joint block, the Simscape Multibody model treats the two halves as rigidly 

connected but independent rigid bodies. Any Gravitational Field blocks in your model then exert a gravitational force at the center 

of mass of each half. This strategy enables you to account for gravitational torques acting on a rigid component, such as an 

asteroid orbiting the Sun. 

The figure shows a simple-pendulum model. In this model, a subsystem block neatly encapsulates each rigid body. The model 

contains two rigid bodies: a pivot mount and a binary link. A joint block separates the mount and the link. 

 

The following figure shows the same model without subsystem blocks. The model treats the blocks on either side of the Revolute 

Joint block as separate rigid bodies. The blocks to the left of the joint block represent the pivot mount, while the blocks to the right 

of the joint block represent the binary link. 

 

If you connect a Weld Joint block between the Main and Rigid Transform1 blocks, the Simscape Multibody model recognizes 

three rigid bodies: 

 Rigid body I to the left of the Revolute Joint block. 

 Rigid body II between the Revolute Joint and Weld Joint blocks. 

 Rigid body III to the right of the Weld Joint block. 

The following figure shows the modified model with the Weld Joint block. The Mechanism Configuration, World Frame, and Solver 

Configuration blocks are omitted to conserve space. 
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Simple and Compound Rigid Bodies 
Rigid bodies can be simple or compound. The difference between the two rigid body types lies in their complexity. Simple rigid bodies typically 
have basic shapes, uniform mass distributions, and a single color. Compound rigid bodies have more complex shapes and, occasionally, 
segmented mass distributions that require multiple Solid blocks to model. 
Consider a binary link, the basic component of mechanical linkages such as the double pendulum and the four-bar mechanism. Depending on the 
level of detail you want to incorporate in your model, you can treat the binary link as a simple rigid body or as a compound rigid body: 

 Simple — Approximate the rigid-body geometry using a standard Simscape Multibody shape. For example, you can model the binary link using a 
brick shape with a uniform mass distribution and a single color. The tutorial Model Simple Link shows this approach. 

 Compound — Model the rigid-body geometry accurately using multiple standard shapes. For example, you can model the binary-link main and 
hole sections using separate Solid blocks, each with its own shape. The tutorial Model Link shows this approach. 

 

Model Four Bar 

Model Overview 

The four-bar linkage is a planar closed-loop linkage used extensively in mechanical machinery. This linkage has four coplanar 

bars that connect end-to-end with four revolute joints. In this example, you model a four-bar linkage using the Binary Link and 

Pivot Mount custom blocks that you created in previous examples. For an advanced application of the four-bar linkage, see the 

bucket actuating mechanism of the Backhoe featured example. 

 

Modeling Approach 

To model the four-bar linkage, you represent each physical component with a Simscape™ Multibody™ block. The linkage in this 

example has five rigid bodies—three binary links and two pivot mounts—that connect in a closed loop through four revolute joints. 

Two of the binary links have one peg and one hole. The third binary link has two holes. The fourth link is implicit: the fixed 

distance between the two coplanar pivot mounts represents this link. 

You represent the binary links and pivot mounts using the custom library blocks that you created in previous examples. You 

represent the four revolute joints using four Revolute Joint blocks from the Simscape Multibody Joints library. 

The two pivot mounts connect rigidly to the world frame. For this reason, the implicit link acts as the ground link. Two Rigid 

Transform blocks provide the rigid connection between the two pivot mounts and the World frame. A translation offset in each 

Rigid Transform block displaces the two pivot mounts symmetrically along the world frame Y axis. 

 

To guide model assembly, you can specify the desired initial state for one or more joints in the model. To do this, you use 

the State Targets menu of the joint blocks. The state targets that you can specify are the joint position and velocity. These are 

angular quantities in revolute joints. You can specify state targets for all but one of the joints in a closed loop. 

file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/gs/model-simple-link.html
file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/ug/model-two-hole-binary-link.html
file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/ref/revolutejoint.html
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Build Model 

To model the four-bar linkage: 

1. Start a new model. 

2. Drag these blocks to the model. The Rigid Transform blocks specify the distance between the two pivot mounts. This 

distance is the length of the implicit ground link. 

Library Block Quantity 

Simscape > Utilities Solver Configuration 1 

Simscape > Multibody > Utilities Mechanism Configuration 1 

Simscape > Multibody > Frames and Transforms World Frame 1 

Simscape > Multibody > Frames and Transforms Rigid Transform 2 

3. Connect and name the blocks as shown in the figure. The base frame ports of the Rigid Transform blocks must connect to 

World Frame block. 

 

4. From the Simscape > Multibody > Joints library, drag four Revolute Joint blocks into the model. 

5. At the MATLAB® command prompt, enter smdoc_compound_rigid_bodies. A custom library with compound rigid body 

blocks opens up. 

6. From the smdoc_compound_rigid_bodies library, drag these blocks. Each block represents a rigid body present in the four 

bar assembly. See the tutorials in the table for instructions on how to create the blocks. 

Block Quantity 

Pivot Mount 2 

Binary Link A 2 

Binary Link B 1 

7. Connect and name the blocks as shown in the figure. You must position the frame ports of the custom rigid body blocks 

exactly as shown. 

file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/simscape/ref/solverconfiguration.html
file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/ref/mechanismconfiguration.html
file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/ref/worldframe.html
file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/ref/rigidtransform.html


MENG233 17 
 

 

Specify Block Parameters 

1. In the Rigid Transform block dialog boxes, specify the offset between the pivot mounts and the world frame. 

Parameter Crank-Base Transform Rocker-Base Transform 

Translation > Method Standard Axis Standard Axis 

Translation > Axis -Y +Y 

Translation > Offset 15 in units of cm 15 in units of cm 

2. In each binary link block dialog box, specify the length parameter. 

Block Length (cm) 

Binary Link A 10 

Binary Link B 35 

Binary Link A1 20 

Guide Assembly and Visualize Model 

The model is now complete. You can now specify the desired initial state for one or more joints in the model. In this example, you 

specify an initial angle of 30° for the Base-Crank joint. To do this: 

1. Double-click the Base-Crank Revolute Joint block. 

2. In the block dialog box, expand State Targets and select Position. 

3. In Value, enter -30 and press OK. 

4. In the menu bar, select Simulation > Update Diagram 

Mechanics Explorer opens with a static display of the four-bar linkage in its initial configuration. If the joint state targets that 

you specified are valid and compatible, the initial configuration matches those state targets. The figure shows the static 
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display that you see in Mechanics Explorer after updating the model. To obtain the view shown in the figure, in the Mechanics 

Explorer toolstrip select the isometric view button . 

 

You can guide assembly so that the four-bar linkage assembles in an open configuration instead. To do this, you must specify a 

position state target for at least one more joint. You do not have to specify this target precisely. If you have a general idea of what 

the target should be, you can enter an approximate value and select a low priority level for that target. 

Closed-loop kinematic chains like the four-bar linkage are especially vulnerable to assembly issues. Even when the model 

assembles, Simscape Multibody may fail to meet one or more state targets. You can check the assembly status of the model and 

of the joints using the Model Report utility: 

1. In the Mechanics Explorer menu bar, select Tools > Model Report. 

2. Examine the model report for red squares or yellow triangles. These shapes identify issues in the assembly or in the joint 

state targets. 

The figure shows the model report for the four bar linkage in the open configuration. A green circle indicates that Simscape 

Multibody satisfied the Base-Crank Revolute Joint state target precisely. A yellow circle indicates that Simscape 

Multibody satisfied the Base-Rocker Revolute Joint state target approximately. 

 

Simulate Model 

Run the simulation, e.g., by selecting Simulation > Run. Mechanics Explorer shows a 3-D animation of the four bar assembly. 

The assembly moves due to gravity, specified in the Mechanism Configuration block. 

Open Reference Model 

To see a complete model of the four–bar assembly, at the MATLAB command prompt enter: 

 smdoc_four_bar 
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LAB PROJECT # 4: 
 

Simulation and Analysis of a Four Bar Mechanism 

Prescribe Joint Motion in Four-Bar Model 

Model Overview 

In this lab, you prescribe the time-varying crank angle of a four-bar linkage using a Revolute Joint block. 

Then, during simulation, you sense the actuation torque at the same joint corresponding to the prescribed 

motion. 

 

Build Model 

1. At the MATLAB® command prompt, enter smdoc_four_bar. A four-bar model opens. This is the model you 
create in tutorial Model Four Bar. 

2. In the dialog box of the Base-Crank Revolute Joint block, specify the following parameters settings. 

Parameter Setting 

Actuation > Torque Automatically Computed 

Actuation > Motion Provided by Input 

Sensing > Actuator Torque Selected 

3. The joint block displays two physical signal ports. Input port q accepts the joint angular position. 
Output port t provides the joint actuation torque required to achieve that angular position. 

4. In each of the four Revolute Joint block dialog boxes, set Internal Mechanics > Damping 
Coefficient to 5e-4 N*m/(deg/s). During simulation, damping forces between the joint frames account for 
dissipative losses at the joints. 

5. Drag the following blocks into the model. These blocks enable you to specify an actuation torque 
signal and plot the joint position. 

Block Library 

Simulink-PS Converter  Simscape > Utilities 

PS-Simulink Converter  Simscape > Utilities 

Scope  Simulink > Sinks 

Signal Builder  Simulink > Sources 

file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/sm/ug/model-four-bar.html
file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/simscape/ref/simulinkpsconverter.html
file:///C:/Program%20Files/MATLAB/R2016a/help/physmod/simscape/ref/pssimulinkconverter.html
file:///C:/Program%20Files/MATLAB/R2016a/help/simulink/slref/scope.html
file:///C:/Program%20Files/MATLAB/R2016a/help/simulink/slref/signalbuilder.html
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6. Connect the blocks as shown in the figure. 

 

7. In the Input Handling tab of the Simulink-PS Converter block dialog box, specify the following block 
parameters. 

Parameter Value 

Filtering and derivatives Filter input 

Input filtering order Second-order filtering 

8. In the Signal Builder window, specify the joint angular trajectory as shown in the figure. 
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This signal corresponds to a constant angular speed of 1 rad/s from t = 1s onwards. 

Simulate Model 

Run the simulation, e.g., by selecting Simulation > Run from the Simulink® menu bar. Mechanics Explorer 

opens with a dynamic display of the four-bar model. 

 

Open the Scope window. The scope plot shows the joint actuation torque with which you can achieve the 

motion you prescribed. 

 


